VAN HAREN PUBLISHING
Author’s guide
Guidelines for submitting manuscripts
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Introduction
This document is the author's instruction from Van Haren Publishing (VHP). Please read and
follow the guidelines properly, as this will speed up the process towards publication of your work.
The author's instruction consists of two main parts:
I.

Guidelines on delivery of your manuscript:

• Technical instructions;
• A checklist to help you deliver the complete manuscript;
• The stages of the publication process and your role in it.
II.

Guidelines for the content:
A General guidelines;
B Specific guidelines (in alphabetical order).
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I.

The manuscript

Technical aspects
VHP expects your manuscript in *.docx (or the older *.doc) file format, the format used by the
most widely used text processing software: MS-Office. Or, alternatively, you can deliver your text
in Adobe InDesign® file format. If you have a problem with delivery in docx, doc or InDesign file
format, please contact your VHP contact person.
Delivery of the manuscript to the publisher is best done as an attachment to an e-mail. In case the
file is larger than 10 Mb, you can upload it to the ftp-server at ftp://www.vanharen.net. You may
also send the document on a USB-stick or a CD/DvD.
You should take into account:
•
•
•

•

Use compression for large files (make a zip file). This is especially desirable with image files.
Submit the illustrations as a copy of the original jpg, tiff, png, Visio, PowerPoint or ai
(Illustrator) files.
Before submitting the manuscript, check that the numbering of figures and tables is correct. If
in an initial test it appears that the numbering and therefore often the references to the
illustrations are incorrect, this might cause quite a lot of problems.
Never use difficult or descriptive names for your illustrations but keep it simple, just use
something like fig.3.2.jpg for the file that contains Figure 3.2 and mark this picture using that
file name.

Example: [Figure 3.2 | file: fig.3.2.pgn | caption: Figure 3.2 Model of the system]
Make regular back-ups of your files while you work on the manuscript, and preferably save a copy
on another location at least once a week. You wouldn’t be the first to lose months of work in a fire,
including the back-up copies you stored near your computer.
Keep a copy of all files you sent to the publisher. This makes communication easier if you have
questions.

Checklist on sending the manuscript
•
•
•
•
•

Is the manuscript complete (text and illustrations)?
Is clearly indicated where illustrations should be placed?
Do all files have a clear, recognizable name?
Has the latest version been sent to the publisher?
Have you backed up all files?

Stages of the process and your role in each stage
Stage 1 – The manuscript
In this first stage you write your text, keeping in mind the guidelines in the next section and your
deadline. Use the guidelines in the next section to avoid future problems with the typographic
designer. This stage ends when your manuscript is accepted by the publisher.
Please try to keep to the delivery date you agreed to. Both the editor and the typographic designer,
who will work with your text in the next stages, have a planning. Earlier delivery is fine, but will
not always help. However, if you foresee that you can’t guarantee the agreed delivery date for some
reason, you should get in touch with your contact at VHP at your earliest opportunity.
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Stage 2 – Editing
In this stage, an editor will carefully read your text and suggest corrections for any errors in
spelling, grammar, and punctuation. The editor uses the ‘track change’ option, so it is clear which
changes are being proposed.
Your role at this stage is to see if the suggested modification, while no doubt better English, still
reflects the meaning of what you intended to write. If so, you accept the change. If not, you rewrite
the text in a way that is both grammatically sound English but does reflect what you intended to
convey. Make sure you take the time necessary to deal with each of the suggestions, because this is
your last real opportunity to rewrite parts of the text which are not yet perfect. The next stages are
mainly about the design of the book.

Stage 3a – Design: ‘proof 1’
In this stage a typographic designer will take over, using Adobe InDesign® or Adobe Illustrator® to
typeset your text and insert the images where they fit on the page, as near as possible to where you
intended them. The designer will decide on the fonts of headers and text, the amount of white space
between headers, paragraphs and other elements, making your text into a beautiful and easy
readable book.
You will receive a pdf file showing your text as it will appear in the book. You can read this file
with a ‘pdf-reader’ program, for instance Adobe Acrobat Reader DC. You can download Adobe
reader for free from https://get.adobe.com/. The Adobe website will check which computer and
operating system version you use and suggest the correct version of the program for you to install.
Open the pdf file in Adobe Reader DC. On the right side of the window you see a yellow
icon, which when you click on it opens a side window with the remarks you make (there
may be some of the editor in there already). You can add remarks by selecting the part of
the text which you want to remark on and then - with your mouse pointer on the selection – click
the righthand mouse button and choose in the menu the action you prefer.
In this stage it is still possible to correct typos and other small mistakes you missed in the previous
step, but you should try to avoid that. In an exceptional situation it is even possible to replace a
section or sub-section, for instance if some unforeseen event makes a part of your text outdated
before it is even published. However, you should try to avoid that too. Ask your contact at VHP if
you think you need this option.

Stage 3b – The cover
About the same time you will receive the cover design, or possibly a few designs for you to choose
the one you like best. And a request to write a cover text for the backside of the book. This is the
text people will read when they peruse a bookstore, so it should entice them to buy your book.

Stage 4 – Design: ‘proof 2’
In this stage you will be asked to check that the corrections you made have been handled the way
you intended. It is still possible to correct small mistakes you see in this stage, but you don’t want
to rewrite parts of the text, and certainly you’ll try to avoid changing illustrations and their place on
the page. It is really far too late in the process to do that.

Stage 5 – Design: ‘proof 3’
This stage is mainly to check that all corrections from the previous stages have been processed
correctly and to add the contents pages and probably an index. After you have done that check, the
book is ‘out of your hands’ in the literal sense, until the moment you’ll be presented the book as it
is going to be sold.
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Stage 6 – Marketing
While the production of the book is in the last stages, you will be contacted by VHP’s marketing
department to write a blog on your book, essentially meant to tell your prospective reader why he
or she should buy the book you wrote. In this stage your possible roles in the marketing will be
discussed too.
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II.

Guidelines for the author (content):

A.

General guidelines

No Formatting please
Manuscripts received by the publisher are forwarded to a typographic designer / graphics company
after editing. Here your files will be converted into a graphics layout program (for instance Adobe
Indesign® or Illustrator®). In order for this conversion to run smoothly, the manuscript should not
contain most of the available MS-Word formatting elements. In particular, you should not use the
possibilities MS-Word provides to influence the design of the text. Your role is to provide the text,
the content of the book. The designer will decide on page design and general layout.
Do not use:
•
•
•
•

options for line, page and document layout;
automatic section numbering and automatic enumeration in lists;
automatic references to paragraphs;
styles, style sets and themes, except for the exceptions mentioned in the next section.

Typing your text
Type your text using the style ‘Normal’ (Standaard)1. Select one font type (one that you can easily
read on your screen) and choose for ‘align left’. On the Layout tab (Indeling), set hyphenation to
‘none’.

Figure 2.1 The Home tab on the ribbon

Then adapt the Normal style to reflect your choices. You do that by first typing a paragraph with
the font and alignment choices you made. Then select this paragraph, and right click on the
‘Normal’ style icon in the Ribbon (Figure 2.1). Choose for the uppermost menu item to set the
Normal style to reflect the settings of the selected text. This way all paragraphs you type will be
left-aligned and have the font type and size you selected.
Bold, italic, super- and subscript
You can use bold (to emphasize) and italics (to emphasize words and for book and magazine
titles). You can also use subscript (like in chemical formulas: H2O; CO2) and superscript (as in
square meter: m2).
Footnotes and Endnotes
To insert footnotes or endnotes, use the appropriate options in your word processor. MS-Word will
automatically enter a superscript footnote marker in your text and create room at the bottom of the
page (footnotes) or at the end of the book (endnotes) where you write the text of the note. MS-

1

In this section we use the names of MS-Word elements as they appear when you have chosen English as
your interface language, followed (within brackets) the name of the elements as they are when you use
Nederlands as your interface language.
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Word will use the style Footnote Text for the footnote/endnote. Using that style presents no
problem and there is no need to change that style.
Small Caps
You can use SMALL CAPS in your texts, for instance for acronyms (abbreviations) like KLM.
Spaces and the [Enter] key
It is good practice to only use the [Enter] key to end a paragraph. Never to add an empty line or to
move a word to the next line. While typing your text, just put a single space after the period ending
a sentence. MS-Word is quite adept to start your text on a next line or next page when needed. You
can, however, use a page break ([Ctrl+Enter] to force a new chapter or section to begin on a new
page.
Do not ever use additional spaces in a line for whatever reason, and neither press the Enter key
twice in a row to create an extra blank line (somewhere in the process the editor will have to delete
those extra spaces and lines). For the same reason you cannot use a [tab] key at the beginning of a
paragraph to indent the first line (which is bad form anyway: the paragraph menu offers that option,
but we don’t use this in a manuscript). Neither should you use [Shift+Enter] to force a word on a
new line within the paragraph. Such a ‘manual line break’ will show up somewhere unexpected
later and probably subvert the design of a page.
Remember: you just type sentences ending with a period and a space. Only at the end of a
paragraph you hit the [Enter] key after the period, starting a new paragraph.
Headings and the Navigation Pane
In order to keep overview over your chapters and sections you can use the standard styles
Heading 1, Heading 2, Heading 3, etc. (Kop 1, Kop 2, Kop 3, etc.).
Using these standard Heading styles makes it possible for you to use the ‘Navigation Pane’ which
gives you an overview of your text, but also gives you the possibility to easily navigate through
your text and even to switch sections of subsections by simply dragging their heading to another
chapter or section. The main text that belongs to that heading is then automatically moved along.
You open the Navigation Pane by going to
the View tab (Beeld) and ticking the relevant
box (marked in the picture).
While using the Heading styles you might
get the idea to change those styles the same
way as described for the Normal style, for
instance to make them Bold or to have some
extra white space before and/or after it. That
is no problem when you use it for your own
convenience, but don’t expect the designer
(in Stage 3) to take your settings into
account.

Figure 2.2 View tab and Navigation Pane
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B.

Specific guidelines

In this section you find specific guidelines in alphabetical order.

Abbreviations
Do not use abbreviations, but write them in full. So: not ‘i.e.’, but ‘that is’; not ‘etc.’, but ‘and so
on’. Words such as CEO, HRM, M&D and R&D may remain, but please note that not all
abbreviations are generally known. Therefore, the first time you use such an abbreviation, write it
in full. Example: The Research and Development department (R&D).

Active voice
Try to use active voice in your text, i.e. a sentence where the subject of the sentence performs the
action stated by the verb. Active voice is easier to read and adds impact to what you write. The
alternative - passive voice - would describe how a subject is acted upon by the verb. Some
examples:
Active Voice
Lions roam the savannah at night.

Passive voice
At night, the savannah is roamed by lions.

As a police officer, you must pass a fitness test
every year

Police officers are required to pass a fitness
test every year.

The teacher answered the students’ questions.

The students’ questions were answered by the
teacher.

The two companies will conclude an
agreement.

An agreement was reached by the two
companies.

Apostrophes
In English, the apostrophe has several functions. The first is to indicate that one or more letters
have been omitted, as in you’ll (you will), it’s (it is / it has) or don’t (do not). In most manuscripts
you will use more formal language, so you would usually avoid these anyway.
The second use is to indicate possession. For a noun, you add an apostrophe and an s to indicate
ownership: the customer’s complaint, the teacher’s response, the children’s toys. But what if the
noun ends with an s? You still add the apostrophe, but not the s: the customers’ complaint indicates
that the same complaint has been received from more than one customer.
Beware of placing an apostrophe where no possession is meant: it’s is a contraction, while its is a
possessive pronoun. The Beatles were popular in the 1960’s is incorrect spelling. There is no
ownership situation here, so you would write that they were popular in the 1960s.

Appendices
In one or more appendices (singular: appendix) to your book you can include material that is
necessary for completeness but that would detract from the orderly or logical presentation of your
text.
Examples are:
•
•
•
•
•

explanatory lists of signs, symbols, quantities, units, abbreviations;
descriptions of methods and techniques;
additional illustrations or tables;
cases;
addresses of employees, authorities.

Usually, you will at least have a list of sources (literature) and an index as appendices.
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Bulleted/numbered list
Use the ‘bulleted list’ option of MS-Word – see the ‘paragraph’ section of the ‘Home’ (Start) tab
in the ribbon.
Primary choice is the bullet. For a second level, use ‘-‘:
•

Example of bulleted list item:
- Second level example 1;
- Second level example 2;
- Second level example 3.

For each list the following applies:
• Lists with (long) sentences:
•
•

each sentence starts with a capital letter and ends with a period.

One- or two-word lists: begin with a lowercase letter and no punctuation at the end.
Lists consisting of parts of a sentence or more than two words: start with a lowercase letter,
end with a semicolon, only the last sentence ends with a period.

Captions for pictures, tables, etc.
The following rules apply to captions:
• no period after the caption;
• a period between the figures of the figure number;
• the first digit is the chapter number. The second digit is the figure number.
Examples:
• Figure 4.1 Configuration management
• Table 3.2 List of elements by atomic number

Figures
See: Illustrations.

Footnotes and endnotes
Try to limit the use of footnotes or endnotes as much as possible. They generally do not promote
the readability of a book. Only use notes if you refer to literature so often that it interferes with the
readability of the text or if you really want to add relevant extra information that does not fit in the
text itself.
If you choose to include notes, you can do so in the form of endnotes or footnotes. We prefer
endnotes. These are then included by chapter at the end of the book. However, in the case of few
notes, footnotes are preferred.

Headings
Divide your text in a well-organized, balanced and consistent way into chapters, sections and any
sub-sections. Start all headings with a capital letter and end without a period. Use the MS-Word
Heading styles (see Chapter II.A), for overview and for your own comfort.

1.

First chapter (use Heading 1 style)
Lorem ipsum dolor sit amet, nominavi voluptua nam ut, tota munere pro et.

1.1

Section (use Heading 2 style)
Est et stet dissentias, quo illud deterruisset cu.

1.1.1 First sub-section (use Heading 3 style)
Mea an nulla laoreet indoctum, nec ex eirmod suscipit postulant.
sub-sub-section (use Heading 4 style)
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If you need more heading levels, do not number them, but use the heading styles (Heading 4, etc.)
and where appropriate use bold, italic and/or font size to distinguish the heading from the text. Try
to limit the number of heading levels to four.

Illustrations (pictures, drawings, formulas, …)
We distinguish between illustrations (photos, graphs, formulas, figures, drawings, etc.) that you
create yourself and illustrations that come from another source. If you use an illustration from
another source, make sure that you do not infringe on copyright. When in doubt, ask for permission
from the copyright holder. Illustrations are meant to clarify the text. Therefore, do not use very
complicated figures.
How to mark an illustration in your text?
There are two possibilities:
1 Mark the place in the manuscript where an image should be placed and put the figure number
and figure name of the figure to be placed between square brackets: [Figure 2.4 Model of …]
2 Include the illustration in the text at the place where it should be in the book. Use the option in
MS-Word to add the caption. Overwrite the automatic number in the caption according the
section: Captions for pictures, tables, etc.
Note: If you are not comfortable with a drawing program and therefore unable to supply a digital
file of an illustration, it is possible to provide a clear, hand-drawn figure.
Screenshots
In a modern version of MS-Word you can add a screenshot of any
open window on your screen using the pertaining option on the
Insert tab (Invoegen). Alternatively, you can make a screenshot of a
window using the following steps:
1. Make the target window ‘active’ by maximizing it (click on the  icon in the upper right corner
of the window).
2. Hold the left [Alt] key and hit the [PrintScreen] key. The screenshot is automatically stored in
your ‘clipboard’.
3. Start PAINT or a similar graphic editor program.
4. Paste the content of the clipboard using the icon marked ‘Paste’(top left-hand side of the
window) or using the key combination [Ctrl]+V.
5. Save the screenshot in a file and give it an recognizable name (like Fig.2.4.png for the fourth
picture in Chapter 2).
This leads to a file with a resolution of about 90 dpi, which converted to the needed width in the
printed work will usually be of sufficient quality.
Digital photos
Photos from the internet (as a jpg or png file) are almost always of insufficient quality (the
resolution is to low). Even photos taken with a digital camera are not always good enough for
inclusion in a book. When submitting photos, make sure they have a resolution of at least 300 dpi.
That means if a photo in the book should be 5 cm (2 inch) wide, the photo should be at least 600
pixels wide (and preferably more). Too large a resolution is never a problem.
You should also make sure the photo is either royalty-free or that you have permission from the
copyright holder to use the photo. In the latter case, save the letter or e-mail proving that
permission to use the photo is granted.
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Language usage
Tailor the language you use to your target audience. Use technical terms or jargon only where and
when useful. Formulate succinctly and not unnecessarily complicated. Clear sentences that are not
too long are usually more effective than long sentences that are difficult to analyze.
Make sure there are not too many passive sentences in the text. Active sentences are easier to read
and increase clarity (see the section on active voice).

Literature / Bibliography, list of sources
All books, research papers and articles cited in the text must also be included in the bibliography.
This list may contain more titles than mentioned in the text. VHP prefers standard APA citation
style.
References in the text
• In the text, refer to publications by putting the author's last name and the year of publication in
brackets: (Johnson, 1998); (Johnson & Peterson, 1999); (Da Silva et al., 1991)
• If you mention the author(s) in a sentence, put the name (s) in the body of the text with the year
in brackets: ‘as described by Johnson (1998)’; ‘this is mentioned by Johnson and Peterson
(1999) and Pereira da Silva (2020)’.
NB: If you do not put the authors Johnson and Peterson in parentheses, then use ‘and’, if you put
them in parentheses, then put an ‘&’ sign.
• If an author has more than one publication to his name in one year, add ‘a’ or ‘b’ to the year.
(Jansen, 1990a).
• If there are more authors with the same surname, please include the initials: (Pfleeger, Ch. P. &
S.L. Pfleeger, 2007; C.A. Johnson, 2003)
• Optionally add a page number to the reference in the text: (Johnson, 1998, p. 56).
• When you make frequent references in the body of text, consider using footnotes or endnotes.
Examples of references in the text
You can insert a reference in your text using (author, year) as a marker, for instance:
Regarding the preparation of the UHDR, (Diggelman, 2014) describes the tedious
discussions between the members of the Committee, …
Or you can use an introductory phrase:
As (Diggelman, 2014) described, ‘the discussions between representants with very different
legal and cultural backgrounds could at times be tedious’.
According to (Diggelman, 2014), the discussions in the preparation Committee to the
UDHR ‘could be tedious at times’.
If in doubt, consult the editor.
Bibliography / List of sources
Quite different standards are being used to list the literature (both sources used and for further
reading) in a bibliography. For references to a book the APA style would look like:
Cazemier, Jacques A., Overbeek, Paul & Peters, Louk. (2010). Information Security
Management with ITIL® V3 (1st edition). Van Haren Publishing, Zaltbommel.
Note: Both the first word and all content words of the title are capitalized.
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When including a book in the bibliography, at least the following elements must be mentioned:
•
•
•
•
•
•

author(s)
full book title
publisher
place of issue
year of issue
edition

A different format applies to an article:
Periñán, Bernardo. (2012). The Origin of Privacy as a Legal Value: A Reflection on
Roman and English Law. In: American Journal of Legal History, Volume 52, Issue 2,
pp 183–201, https://doi.org/10.1093/ajlh/52.2.183.
In any case, the following elements should be included:
•
•
•
•
•
•
•

author (s)
title of the article
magazine
volume
issue
year
page numbers

Note:
• Sort the list alphabetically by the first author's last name.
• When alphabetizing, ignore prefixes like ‘da’ in ‘da Silva’ or ‘van’ in ‘van Beethoven’.
Note that in the list the prefixes come after the initials: Silva, José da; Braun, Wernher von;
• If the same surname occurs more than once, sort their publications by initial(s).
• If more publications of the same author are listed, order them by publication date.
• For publications by four or more authors, only mention the first three.
• A helpful (free) citation generator can be found at https://www.bibme.org/apa.
If it appears that the bibliography contains many errors or that a lot of data is missing, it will be
returned to the author!

Numbers and years
• Numbers from zero to twenty and round numbers are written out completely, if no factual and
exact statements are made.
For instance: ‘I have sent five proofs’; ‘More than three hundred people have responded positively
to our letter’.
• Business - and exact statements are shown in numbers. For instance:
This laser printer has a print resolution of 600 dpi.
• When writing numbers and amounts of money in English, the period is used as decimal
separator (€ 99.50). Use the euro symbol for amounts and not the letter ‘E’. On an
American/international keyboard [Alt Gr+5] yields an € sign. You can also find this sign in MSWord under Insert » Symbol.
• Years must be in numbers (2019). References to the last century: ‘in the 1960s’ and not: ‘in the
sixties’ or ‘in the 60s’.
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• Numbers up to and including 9999 do not receive a thousand indicator. Figures from ten
thousand up are written as 10,000.

Quotation marks
• Always use the single quote (‘word’) as quotation mark.
• For a quotation within a quotation (nested quotation) use a single quotation mark around the
total quotation and double quotation marks on either side of the quotation within the quotation.
Example: The convenor reported, ‘The committee said that it “did not receive the information”,
at least not on time’.
• The order of the quote mark and the period at the end of a sentence depends on whether you
quote a part of a sentence, or a complete sentence:
The committee said that it ‘did not receive the information’.
The committee said: ‘Unfortunately we did not receive the information on time.’

Quotes
Quoting means copying a passage of someone else’s words and crediting the source. In a quote you
copy the literal text of a source (book, magazine article, website, etc.), without any changes. The
idea being that even the smallest change like omitting a comma can severely alter the meaning of
the sentence you (mis)quoted. If you want to shorten the quote because a part is not relevant, you
can signal this using ellipses (…):
Original quote:

The principles of, and rules on the protection of natural persons with regard to the processing of
their personal data should, whatever their nationality or residence, respect their fundamental
rights and freedoms, in particular their right to the protection of personal data.
GDPR, 2016, Recital (2)
Shortened quote:

The principles of, and rules on the protection of natural persons with regard to the processing of
their personal data should … respect their fundamental rights and freedoms, …
(GDPR, 2016, Recital (2)
Typos and additions
As stated, in principle you copy the literal text of a source. That includes typos. If needed, you can
mark the typo by putting [sic] behind it. Sic is Latin for ‘as such’, indicating that you copied the
typo from the original:
The reporter wrote: ‘while taking the call the chairman stept [sic] out of the room.’
Or alternatively you can indicate that you changed a word in the quote:
The reporter wrote: ‘while taking the call the chairman [stepped] out of the room.’
Instead of square brackets you can also use round brackets: (stepped).
If you quote more than three lines, you might want to start a new paragraph and indent it:
The protection of natural persons in relation to the processing of personal data is a
fundamental right. Article 8(1) of the Charter of Fundamental Rights of the European Union
(the ‘Charter’) and Article 16(1) of the Treaty on the Functioning of the European Union
(TFEU) provide that everyone has the right to the protection of personal data concerning him
or her.
In that case you do not need surround the quote with quote marks or place it in italics.
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References
When referring to figures, tables, diagrams, etc., only use the number (figure number, table
number, etc.). Do not refer to page numbers (you don’t know on which page the figure will be).
Neither use terms like ‘the figure below’ or ‘the figure on the left’.

Spelling
A good reference is the New Oxford American Dictionary or the Oxford Dictionary of English. If
you have an e-reader, you might have a copy of one of these already in your reader.
Be consistent
Most importantly, be consistent. For example, if you choose for the word ‘data’ to be handled as
singular, as is done in modern English, then do that for every instance of the word data. Not in one
place ‘data is valuable’, and on a next page ‘data are important’.

Tables
In addition to plain text, your manuscript may contain tables.
Always use the table function in MS-Word when inserting tables.
• Just like with figures, you should number the tables you use
consecutively, per chapter. So the second table in Chapter 3 will
be referred to as ‘Table 3.2’.
Beaufort Air speed
scale
in m/sec
• Each table must be referenced to in the text. Do
1
<1
this, for example, by including the phrase ‘see
2
1-2
table 3.2’ in your text.
3
2-3
• Always state the source where you derived the
4
4-5
table from, in brackets, unless you have made the
5
6-8
table yourself. For instance ‘(Jones, 2017)’.

Wind descriptive
terms
Calm
Light air
Light breeze
Gentle breeze
Moderate breeze
Table 3.2 Beaufort wind force scale
(MetOffice, 2020)
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